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This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.1.0 (Released 2014-10-01) 

Bridge Modeler 
Enhancements Implemented 

* Incident Description 

* 68905 The precast concrete-U girder bridge section in the Bridge Modeler now permits nonprismatic 

variation of the concrete-U girder sections themselves, including for superstructure design and 

rating. Generated models include the spine model, as well as area models of the slab with the 

girders modeled as frames or as areas. Previously nonprismatic section properties were only 

available in the Bridge Modeler for steel-I, steel-U, and concrete-I girders. 

* 69233 A new type of bridge object has been added to the Bridge Modeler for segmentally-constructed 

bridges. When defining a segmental bridge object, the user has direct control of the length, number, 

type, erection method, and naming convention of the segments in each span. The entire bridge 

object is effectively assembled from specified span-discretization schemes that allow for balanced 

cantilever or span-by-span construction methods.  

The tendon layout and definition for segmental bridges follows the industry standard of tendon 

categorization based on their geometry and sequence of installation. The available categories are: 

Cantilever, Bottom Span, Top Span, and Continuity. Each category features a specialized input 

form that facilitates very fast and efficient batch-mode tendon definition and provides 

immediate plotting of defined tendons and segments in various non-proportional scales for quick 

checking. In addition, general tendons may be defined as needed. 

Bridge groups will be automatically created for each segment, and for the support bearings and 

substructures. Staged-construction schedules and load cases can then be easily created with 

reference to these bridge groups. 

 71422 Minor changes have been made to the behavior of the Bridge Modeler when updating a bridge 

object:  (1) When clearing a linked bridge object, unused section properties, constraints, and other 

properties that had been previously created automatically for the bridge object are now removed. 

This simplifies the model.  (2) The Undo command is no longer available immediately after 

updating, clearing, or unlinking a bridge object. This was previously available but should not have 

been, since it can be inconsistent with user actions. Undo is still available for subsequent user 

actions, but not for the automatic operations of the Bridge Modeler. 

 72679 An enhancement has been implemented for the Bridge Object Data form used to add or modify a 

bridge object. The form now allows the location of spans along the layout line to be specified using 

span length as well as by station. 

 73289 An enhancement has been implemented to add a solid concrete girder deck section to the Bridge 

Modeler. This section consists of a concrete slab with integral concrete girders of rectangular or 

trapezoidal shape. Options for updating the linked bridge model include the spine model and an area 

model where the slab is modeled with area (shell) objects and the girders are modeled as individual 

frame objects. A variable depth solid concrete diaphragm is available for this section. Force, stress, 

and displacement results are available for the entire bridge section and the individual girders. 
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Modeling 
Enhancements Implemented 

* Incident Description 

 13735 An enhancement was implemented to add a library containing the WSDOT (Washington State 

Department of Transportation) standard precast I-girder and bulb-tee girder frame section 

properties. 

 39848 An enhancement was implemented to allow the definition of bridge precast concrete I, U, and bulb 

tee girder frame section properties in XML library files that are read by the software for quickly 

adding new standard frame sections for these shapes. Users can define their own libraries and either 

add them to the subfolder .\Libraries\Frame Sections in the installation directory or into subfolder 

.\Computers and Structures\CSiBridge 2015\Libraries\Frame Sections within their local user folder. 

* 47359 An enhancement was implemented to allow modification of the model geometry based on the shape 

of a buckling or modal case mode. This can be used to simulate imperfections or other scenarios. 

Once applied, the geometry can be reset to the original. 

 73291 An enhancement has been implemented to provide a warning message if a mass source definition 

includes both element self-mass and at least one load pattern with a self-weight multiplier greater 

than zero, possibly resulting in double counting of the self-mass. 

* 76109 An enhancement has been implemented to now allow mass assigned to null objects to be accounted 

for during analysis. Previously mass could be assigned to null objects but was not considered during 

analysis. Old models that had mass assigned to null objects will now have different results for any 

load cases that account for mass. 

 76130 An enhancement was implemented to add a new trapezoidal concrete frame section property. This is 

similar to the rectangular concrete shape, except that the top and bottom widths may be different. 

Concrete frame design for these sections is not currently available, as they are intended primarily 

for use in the new Concrete Solid Girder bridge deck section. 

* 76434 An enhancement has been implemented to allow specification of scale factors for the material time-

dependent properties controlling creep, shrinkage, and stiffness for concrete; and relaxation for 

tendons. For creep, shrinkage and relaxation, these factors multiply the calculated strain. For 

stiffness, the factor multiplies the modulus of elasticity at any given time. 

Section Designer 
Enhancements Implemented 

* Incident Description 

 73935 

75383 

Section Designer has been enhanced to provide more detailed information in the message displayed 

when an error is encountered while displaying the Concrete Model Form. Such errors are typically 

due to an invalid specification of a Mander-Confined material that adversely affects the calculation 

of the stress-strain curve. 

 22355 Section Designer has been enhanced to allow prestressed tendon layouts to be drawn directly using 

the same tools used to draw rebar layout. Previously tendons could only be defined within Caltrans 

shapes. Selecting a tendon material for the drawn shape allows specification of the tendon force. 

Available shapes include point, line, rectangular, and circular layouts, as well as the reinforcing 

included as part of the rectangular, circular, and polygon concrete shapes. The tendon size, material, 

and prestress force affect the moment-curvature relationship, and hence affects Caltrans frame 

hinges defined from Section Designer sections. Fiber hinges and non-Caltrans PMM hinges are not 

affected. The PMM interaction surface used for design is not affected, but treats the tendon as 

reinforcement without prestress. 
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Loading 
Enhancements Implemented 

* Incident Description 

* 18433 An enhancement has been implemented to allow standard vehicles to be defined in XML files for 

import into models. All previously available standard vehicles are now available in this XML 

format using the Import Vehicles command. Users can define their own libraries and either add 

them to the subfolder .\Libraries\Vehicles in the CSiBridge installation folder or into the subfolder 

.\Computers and Structures\CSiBridge 2015\Libraries\Vehicles within their local user folder. 

* 18434 

19077 

Horizontal moving loads may now be considered in influence-based moving load cases, including 

the effect of braking/acceleration loads and centrifugal forces. Horizontal loads are computed as 

proportional to the vertical loads defined for each vehicle, with factors specified in the vehicle 

definition for braking/acceleration coefficients, centrifugal coefficients and velocity, overturning 

effects, and super-elevation effects. The centrifugal radius is specified as part of the lane definitions, 

and is independent of the geometry of the layout line. Each moving load case may consider any 

combination of vertical, braking/acceleration, and/or centrifugal loading. Overturning moments due 

to centrifugal and super-elevation effects are represented as vertical force couples and are limited so 

as not to cause uplift on the unloaded wheels; for this reason, overturning moments are most 

conservatively analyzed when combined in the same moving load case with vertical load. In 

addition, moving load analysis has generally been made more efficient by only running those 

vehicles on lane influence surfaces actually needed for the load cases being run; previously, all 

vehicles were always run on all lanes. 

* 67707 An enhancement has been made to add automated response-spectrum functions for Argentina, 

Chile, Colombia, Dominican Republic, Ecuador, Guatemala, Mexico, Peru, and Venezuela. 

 72359 An enhancement has been implemented to allow the definition of notional load patterns by 

specifying a base load pattern and a load ratio. 

* 74815 Auto seismic loading and response spectrum function for Eurocode 8-2004 has been updated for 

Norway National Annex EN 1998-1:2004 NA:2014. 

Analysis 
Enhancements Implemented 

* Incident Description 

 71596 

72252 

The file-size limit for internal files used for analysis has been increased from its previous 2GB limit. 

The new limit defaults to 100GB, but this can be changed using the environment variable 

SAPFIRE_FILESIZE_MB to 1TB or more. This change will not affect most users and most models, 

since the previous limits were exceeded in very few cases. The new larger size limit applies to 

NTFS files systems only. FAT32 file systems are still limited to 2GB. Most files used for analysis 

will have the new larger capacity, although a few files may still exhibit limits for other reasons, 

such as the number of objects that can be handled. For most practical problems, the amount of disk 

space and other system resources will control the size of the model and associated analysis files that 

can be handled. 

 76508 Computation of the nonlinear behavior of link elements has been parallelized to increase the speed 

of analysis for nonlinear static, nonlinear direct-integration time-history, and nonlinear modal time-

history (FNA) load cases. This will primarily impact models having a large number of link objects 

or a large number of link elements generated to represent line or area spring supports. Analysis 

results may change slightly in sensitive or ill-conditioned models, but should otherwise not be 

affected. 

 76511 The behavior of the isotropic interacting frame hinge has been improved, particularly with respect 

to the handling of changes in bending ductility due to changes in axial load. In addition, the 

behavior when the hinge is collapsing due to a drop in the moment capacity has been improved. In 

certain rare cases, the moment-rotation results would deviate significantly from the backbone curve 

during such drops, and this has been largely resolved. Note that deviations from the backbone curve 

are expected when the axial force or M2:M3 ratio changes due to movement around the interaction 

surface. The affected hinges types are P-M2-M3, P-M2, P-M3, M2-M3, excluding fiber hinges and 

single degree-of-freedom hinges. For most models, the effect of these changes will be insignificant. 
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Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 13401 

25713 

62522 

Superstructure displacements are now available for plotting and output on the Bridge Object 

Response Display form using the command Home > Display > Show Bridge Superstructure 

Forces/Stresses. Displacement results are available for the entire section along the layout line and 

for individual girders or webs along their individual lines. Displacement components provided 

include vertical, transverse, and longitudinal translations, plus rotation about the longitudinal axis 

(torsion). Result locations for the girders and webs depend upon the type of bridge section and how 

it is modeled. For girders, the torsional rotation is computed as the relative transverse displacement 

per depth of the girder. Displacement results can be plotted at the section-cut locations where forces 

and stresses are reported or at the tenth points of each span. Plotted results can be displayed in a 

table and exported to Excel. In addition, the Bridge Object Response Display form has been 

enhanced for all result types (forces, stresses, displacements) to show location based on the layout 

line or individual girder line, and from the start of the bridge object or the start of each span. 

Previously distance was always measured along the layout line from the start of the bridge object. 

Bridge Design 
Enhancements Implemented 

* Incident Description 

 69749 

73155 

Bridge design of steel-girder superstructure sections has been enhanced by adding the calculation of 

the negative plastic moment capacity for steel I- and U-girder sections where the plastic neutral axis 

(PNA) falls into bottom flange. Previously those sections were flagged a not valid, and no design 

results were provided. This enhancement affects all design and rating requests for steel I- and U-

girder sections for all design codes. 

 73676 An enhancement has been implemented for the bridge design and rating progress form to show 

additional status details for the requests being run. 

* 76388 An enhancement has been implemented adding bridge superstructure design according to AASHTO 

LRFD 2014 (7th Edition), including the 2015 interim revisions as an option. This also affects bridge 

rating when used as the underlying resistance code. 

* 76389 Bridge superstructure rating for the AASHTO code has been revised to account for the 2014 and 

2015 interim revisions. The name of the rating code, as referenced in the Bridge Rating Preferences 

form and documentation, has been changed from "AASHTO Rating 2011" to "AASHTO Rating 

2010", and a new option has been added to select the interim revision: "No Interims", "2011 

Interims", ..., "2015 Interims". The choice of the interim appears in the output and reports, but 

actually has no effect on the results as the changes in the code do not affect the superstructure rating 

requests as implemented in CSiBridge. In addition, two new options have been added to the Bridge 

Rating Preferences to select the AASHTO design code and corresponding interim revisions to be 

used for resistance calculations. These too will be reported in the output and reports. Changes in 

these codes and interims may have an effect upon the results. No change was made for 

superstructure rating using the "AASHTO LRFD 2007" code. 

 77525 A tolerance value has been added to the AASHTO LRFD criteria for the determination of stiffened 

versus unstiffened web panels. The web panel is now classified as stiffened when the stiffener 

spacing d0 satisfies d0<=3D+Tol (AASHTO LRFD 6.10.9.1 without longitudinal stiffeners) or 

d0<=1.5D+Tol (AASHTO LRFD 6.10.9.1 with longitudinal stiffeners), where D is the web height 

and Tol is the Auto Merge Tolerance specified in the model settings (command File > Settings > 

Tolerances). This change allows web panels to be considered as stiffened that previously were 

intended to exactly satisfy the limiting case but failed due to numerical round-off. 
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Frame Design 
Enhancements Implemented 

* Incident Description 

 40516 An enhancement has been implemented, adding steel frame design according to AISC ASD-89 and 

AISC ASD-01. 

* 75246 An enhancement has been implemented, adding concrete frame design according to the ACI 318-14 

code. 

* 75247 An enhancement has been implemented, adding steel frame design according to the new 

Canadian CSA S16-14 code. 

* 75248 An enhancement has been implemented, adding concrete frame design according to the new 

Canadian CSA A23.3-14 code. 

Data Files 
Enhancements Implemented 

* Incident Description 

 73403 The definition of schedules created by the Construction Scheduler is now incorporated in the model 

file (.BDB). Previously this data was stored in a separate file (.BCS). Construction schedules are 

now also available in the database tables for display and editing, and for export and import to text, 

Excel, and Access files. 

Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 75813 New functions have been added to the CSI API (Application Programing Interface) to set and 

retrieve the GUID (Globally Unique Identifier) for point-object force loads, cable-object distributed 

loads, and frame object concentrated or distributed loads. A separate GUID applies for each 

individual load assignment to an object. The GUID is now automatically created whenever any of 

these load types is assigned to an object, whether by using the API, graphical user interface, or 

database tables. In addition, GUIDs are now automatically generated for each new object when 

created. 

Documentation 
Enhancements Implemented 

* Incident Description 

 73336 

76108 

An enhancement has been implemented, updating the API documentation to include Visual C++, 

Python, MATLAB, and Fortran examples. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 71128 

71493 

71599 

The check for updates feature has been modified to be less intrusive. Now when an update is 

available a small icon will appear in the upper right corner of the main window to indicate this. 

Clicking on the icon will take the user to a website providing details on how to obtain the update. 

The Help > Check for Updates command remains.  

 71221 The version number has been changed to v17.2.0 for a new minor release. CSiBridge v17 is known 

as CSiBridge 2015. 
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User Interface 
Incidents Resolved 

* Incident Description 

 71092 An incident has been resolved that addressed several unreported "Abnormal Termination" errors 

that could occur when working with the graphical user interface. When these errors occurred, the 

model could be saved before the software terminated to prevent loss of data. Results were not 

affected. 

 71555 An incident was resolved in which an abnormal termination would sometimes occur when trying to 

edit mixed bridge group types. 

 71754 An incident was resolved for three minor usability items: (1) When using the menu instead of the 

ribbon, no recent models were shown on the File menu . (2) When using the menu, the advanced 

menu option was not saved between sessions.  (3) The unit settings were not saved between 

sessions. 

 72067 An incident was resolved in which an abnormal condition could occur when clicking the 'Export To 

Excel' button on the 'Bridge Object Response Display' form. This was a user interface issue only 

and did not affect results. 

 72110 An incident was resolved in which an abnormal condition could occur when modifying or deleting 

existing vehicles. This was a user interface issue only and did not affect results. 

 72477 

72868 

An incident was resolved in which an input field validation message on the Bridge Section Data 

form was unable to be closed in order to correct the input data. This was a user interface issue only. 

 72633 An incident was resolved in which an abnormal condition would occur when using the ribbon 

button to copy a lane that was defined based on frames. This was a user interface issue only and did 

not affect results. 

 73195 An incident was resolved correcting two items related to using the menu interface instead of the 

ribbon interface. (1) After switching to the advanced menus, the option was not maintained the next 

time the software was run. (2) A window title was not displayed to identify what was displayed in 

the window. Both items were user interface issues only and did not affect results. 

 73198 An incident was resolved in which an abnormal condition could occur when manipulating data on 

the 'Define Parabolic Tendon Vertical Layout by Points' form. This was a user interface issue only 

and did not affect results. 

 73394 An incident was resolved where the plot on the 'Length Effects for Axle or Uniform Loads' forms 

was blank. This was a user interface issue only and did not affect results. 

 73649 An incident was resolved in which an abnormal termination could occur when modifying bridge 

groups. This was a user interface issue only and did not affect results. 

 73773 An incident was resolved in which an abnormal termination error could occur for certain models 

when changing to extruded view. This was a user interface issue only and did not affect results. 

 74054 An incident was resolved where it was not possible to add or modify vehicle classes in the graphical 

user interface. Vehicle classes could be added or modified using the interactive database editor. The 

automatic vehicle classes created for each individual vehicle were not affected. No results were 

affected. 

 74164 An incident was resolved in the Define Bridge Section Data form for advanced box girder sections 

in which setting the option to specify a radius for calculation of some of the fillet data would auto-

calculate the fillet values, but still let the user input values in the fillet fields. The user input values 

would revert to the auto-calculated values and therefore the results matched the model definition. 

The fields are now locked from user input when applicable. 

 74369 An incident was resolved where the distance values in the Lane Loading Points form were always 

shown in the model database units instead of the specified display units. 

 74689 An incident was resolved in which the traditional menu item (not the ribbon) Display > Show 

Superstructure Forces/Stresses was enabled when there were no bridge objects in the model. 

 74793 An incident was resolved for the Load Case Data - Nonlinear Static Staged Construction form in 

which a long name in the Data For Stage section of the form would result in a horizontal scrollbar 

obscuring part of the input data. This was a user interface issue only and did not affect results. 
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* Incident Description 

 75269 An incident was resolved in which the Add button on the Vehicle Class Data form was not enabled, 

preventing adding of new vehicle classes through the form. Built-in vehicle classes were not 

affected. Vehicle classes could be added through the interactive database editor. This was a user 

interface issue and did not affect results. 

 75998 An incident was resolved for the Bridge Modeler where entering invalid data in the Bridge Bent 

Column Data form (command Components > Substructure - Bents) could generate an error message 

that could not be closed, such that the user was unable to go back to the form to correct the data. 

This required the software to be terminated and restarted. 

 76494 An incident was resolved in which the Bridge Lane Data form would increase in size when opening 

it multiple times. This was a GUI issue only when using large fonts and did not affect results. 

 77511 An incident was resolved where the load case tree may not display correctly when more than one 

staged construction case starts from a single staged construction case. 

 78904 An incident was resolved in which the Vehicle form could grow in size when opened repetitively. 

This was rare and typically occurred when using large font Windows settings. This was a user 

interface issue only. 

Graphics 
Incidents Resolved 

* Incident Description 

 59395 An incident was resolved in which the 'Offset' view type would sometimes show offsets where they 

were not applied. This was a graphical issue only and did not affect results. 

 73594 An incident was resolved where the Offset view option (command Home > View > Set Display 

Options > View Type > Offset) was drawing frame objects at the center of the section bounding box 

rather than at the centroid (neutral axis) of the frame section. This was incorrect for unsymmetrical 

sections such as channels, angles, T-sections, and some Section Designer sections. This was a 

display issue only and no results were affected. The extruded view option was drawn correctly. 

 74495 An incident was resolved in which the bent columns were sometimes not correctly displayed in 

extruded view as a result of incorrect nonprismatic bent column sections as described and resolved 

in Incident #74427. 

Bridge Modeler 
Incidents Resolved 

* Incident Description 

 69751 An incident was resolved for the Bridge Modeler where the bent bearings may be generated 

incorrectly at the beginning of the span for a steel U-girder bridge model when two internal cross-

diaphragms, in the same or different girders, were assigned near a bridge section cut location in that 

span. When this occurred the error was obvious and the results agreed with the model as generated. 

 71365 An incident was resolved for the Bridge Modeler where the software would terminate with an 

Abnormal Termination error message when assigning to a bridge object a Steel U-Girder deck 

section having only a single girder. When this occurred, no results were available. 

 71404 An incident was resolved for the Bridge Modeler where bridge groups that are defined in terms of a 

station or distance range could include objects outside of the specified range. This was most likely 

to occur in larger models. When this occurred, the effect was obvious by looking at the objects 

selected using the generated groups, and results agreed with the model as generated. This error 

affected versions 17.0.0 to 17.1.1. 

 73515 An incident was resolved for the Bridge Modeler in which the feature to copy a tendon to all girders 

(command Bridge > Bridge Objects > Prestress Tendons) did not always work when a parametric 

variation was assigned to the second or subsequent span, and the distance for the parametric 

variation was specified to be measured from the beginning of the span. When this occurred the 

effect was obvious and results agreed with the model as generated. 

 73915 An incident was resolved for the Bridge Modeler where defining a composite bridge deck section 

with zero overhang length and an overhang thickness greater than the slab thickness would cause a 
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* Incident Description 

warning message "Steel Girder with Composite Slab - Invalid thickness of composite slab." to be 

generated when running superstructure design or rating requests and displayed in the corresponding 

status table. When this occurred, affected design results were not available. In addition, plotted and 

tabulated superstructure stress results for the exterior slab and composite girder adjacent to this 

overhang could be reported as zero. No other results were affected. This situation was not common, 

and when it occurred, the error was limited and obvious. 

 74246 An incident was resolved for the Bridge Modeler where an error message was sometimes generated 

when defining bridge groups that stated that a distance specified exceeded the span length, when in 

fact it did not. This was due to a tolerance check and could be avoided by setting the distance to a 

slightly smaller value. The tolerances have been adjusted to correct this problem. Results were not 

affected. 

 74427 An incident was resolved for the Bridge Modeler where a nonprismatic frame section assigned to 

the bent column may not have the lengths of the variable segments properly distributed along the 

height of the column. The various length should be apportioned along the clear length from the 

bottom of the column to the bottom of the bent cap, but were instead being calculated as if 

distributed along the length from the bottom of the column to a point within the bent cap. When this 

occurred, analysis could be affected, although the effect was generally small. 

 75437 An incident was resolved for the Bridge Modeler that affected the generation of seismic hinges in 

the bent columns for automated Bridge Seismic Design: When the "Concrete Hinge Type" option in 

the Bridge Seismic Design Preferences form was set to "Auto: From Bent", and the "Seismic Hinge 

Data" property on the Bridge Bent Column Data form was set to "None" for the top and/or bottom 

hinge in any of the columns, no hinges would be generated for any of the subsequent columns in 

any bent using that bent property. Results agreed with the model as generated. 

 75523 An incident was resolved for the Bridge Modeler where the superstructure continuity conditions at 

the support bents could be incorrectly generated when the bridge object was updated as a spine 

model. When the two end joints of the spine-model frame objects for the two adjacent spans did not 

share the same location at the bent, then either (1) continuity was being enforced with a body 

constraint at double-bearing bents even when discontinuity was specified, or (2) continuity was not 

being enforced with a body constraint at single-bearing bents even when continuity was specified. 

When this error occurred, the effect was obvious from the deformed shape and superstructure force 

and moment plots. This did not affect bridge objects updated as area or solid objects. The common 

case of spine models where the end joints of the adjacent spans were at the same location was not 

affected. 

 75878 An incident was resolved where in certain rare instances of tendons modeled as loads on frame 

sections with non-prismatic section properties, the loading could be incorrect. When this occurred 

the effect was obvious. 

 76378 An incident was resolved for the Bridge Modeler affecting steel I-girder bridge models with the 

girder webs modeled as area objects and having either skewed supports or a curved layout line 

where certain area and frame objects associated with cross frames (diaphragms) could be removed 

from the generated model when cross-frames were assigned at the same location to the left side and 

right side of an interior girder and both cross-frames included a “both-sides” type of connection 

plate. The affected area and frame objects would be present when the linked model was first 

updated from the bridge object, but could then be removed after the model was saved or the 

database tables were opened. When this occurred, the effect was obvious, and results agreed with 

the model as visible. This error was not common. 

* 76694 An incident was resolved for Bridge Modeler where the wrong steel material property could be used 

in the model created for steel I and U girder bridge sections when (1) A girder was assigned with a 

non-prismatic section, (2) The girder was modeled as shell or mixed type, (3) The nonprismatic 

segment boundary location was not at a bridge section-cut location, and (4) The section material 

was different before and after the segment boundary. When all four conditions were true, the girder 

section material would be the same before and after the nonprismatic segment boundary instead of 

being different. This normally had no effect on the analysis results because the modulus of elasticity 

is generally the same for all steel materials. However, design results could be affected if the yield 

strengths were different between the two materials. 
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* Incident Description 

 77653 An incident was resolved for the Bridge Modeler where rebar could be added into the wrong span 

when using the Bridge Girders Reinforcement Layout form (command Bridge > Bridge Objects > 

Girder Rebar) when the name of one span was contained in the name of another span. For example, 

rebar added to span "Span23" would instead be added into "Span2". When this occurred, the design 

results agreed with the model as generated, which could be seen from the design results tables or 

revisiting the Bridge Girders Reinforcement Layout form.  

Modeling 
Incidents Resolved 

* Incident Description 

 70305 An incident was resolved where Caltrans-type frame hinges could not be assigned to frame 

members using Section Designer sections defined as Caltrans shapes having tendons but no mild 

reinforcing steel. This is now possible provided that the specified tendon tension is within realistic 

limits for the concrete and tendon materials in the section. 

 72093 An incident was resolved where the Quick Start form for the horizontal layout of circular bridge 

tendons was not creating the correct tendon layout. Results agreed with the model as generated. 

 77406 An incident was resolved in which opening the construction scheduler would change the notional 

size for frame elements from Auto to User. 

Section Designer 
Incidents Resolved 

* Incident Description 

* 71170 An incident was resolved in Section Designer where the section properties were calculated 

incorrectly if the Section Designer section (1) Contained a structural shape assigned with a concrete 

material, and (2) the Reinforcing for this shape was set to "Yes", and (3) the Rotation Angle for this 

shape was not zero. The section properties were being transformed twice for the nonzero angle in 

the case. Structural shape without reinforcing were not affected. 

Analysis 
Incidents Resolved 

* Incident Description 

 47913 An incident was resolved where the shell response (resultants and stresses) could be all-zero for a 

moving-load cases that used the stiffness from the end of a staged-construction load case. This was 

not common. When this did occur, the error was obvious. 

* 61372 An incident was resolved where a torsional release applied to the end of a frame object with a 

section property having shear-center eccentricity (e.g., a channel section) did not result in zero 

torsion where expected, and in some cases could cause an unexpected shear force V2. When this 

occurred, the error was obvious from the torsion and shear reported in the frame object. Load 

patterns used in a mass-source specification that caused large shear in an affected member could 

also cause errors in the calculated mass if the member was short and the shear error was large. 

Otherwise, the practical effect on structural response was generally insignificant outside the 

member itself. Now when torsional and/or shear releases are specified in a frame member, shear-

torsion coupling is ignored for that member. 

* 70951 An incident was resolved where the convergence behavior of the triple-pendulum isolator (link 

property) was poor for circumferential behavior. This could cause time-history load cases with 

independent loading in two directions to run slowly or to not converge, in which case results were 

not available. Radial behavior (along a fixed shear direction in the U2-U3 plane of the isolator) was 

not strongly affected. The overall convergence behavior of the triple-pendulum isolator has been 

made more efficient, and some small difference in results may be expected even for radial behavior. 
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* Incident Description 

* 71962 An incident was resolved where the results for the triple-pendulum isolator could be incorrect when 

recovered after running a nonlinear load case. The results of a nonlinear load case starting from zero 

initial conditions were not affected except for the triple pendulum isolators themselves: the results 

for the joints and all other elements were correct. However, the results for any nonlinear case 

continuing from a previous nonlinear case could be affected by the incorrect results for the triple 

pendulum isolators from the previous nonlinear case. 

 73432 An incident has been resolved where the shear factors "factV2" and "factV3" in the formulas used to 

calculate shear stresses S12 and S13 for the circular frame section at the points 2, 3, 6 and 7 (angles 

315, 225, 45 and 135 degrees, respectively) should have been R^2 / 6 instead of R^2 / (3*sqrt(2)). 

The computed results agreed with the formulas as documented in the technical note "Frame Stress 

Calculation". In addition, the shear factors "factV2" and "factV3" in the formulas for S12 and S13 

for the pipe frame section at the same location have been enhanced to use an exact analytical 

solution without the thin-walled assumption. Only analysis results are affected by these changes. 

Design results are not affected. 

 73557 An incident was resolved where the analysis would terminate with an error message on certain 64-

bit Windows 8.1 machines when using the 64-bit solver with the Advanced or Multi-Threaded 

options. When this error occurred, no results were available. 

 76889 An incident was resolved where the results for moving load cases were presented without 

correspondence for area (shell, plane, and asolid) and solid objects, even when correspondence was 

requested for the analysis. The results presented were always the maximum and minimum values 

for each force or stress component, and hence were conservative. Results for joint displacements 

and reactions, frame forces, and link forces and deformations were not affected by this incident. 

 78935 An incident was resolved where an exception could occur and the analysis terminated when running 

a moving load case for cable objects while using the 64-bit solver. When this occurred, results were 

unavailable. Results were otherwise unaffected. Models that did not contain cable objects or that 

were set not to consider moving load on cable objects were not affected. This error did not occur 

when using the 32-bit solver, such as when running the analysis in the GUI process (as set using the 

command Analysis > Analysis Options > Solver Options). 

Bridge Design 
Incidents Resolved 

* Incident Description 

 70741 An incident was resolved for bridge seismic design where the pushover load cases for design 

requests of seismic design category D could fail to converge if any bents were defined in the bridge 

modeler without any columns. In such a case, the bent having no columns and all subsequent bents 

would use the wrong generalized displacement for loading control, and no results would be 

obtained. Results for the previous bents were unaffected. Now pushover load cases are not created 

for bents having no columns. 

 71931 An incident was resolved for bridge superstructure design using the Eurocode-3 code where the 

software could terminate unexpectedly while performing either the "Steel I Composite Bridge 

Constructability - NonStaged" or the "Steel I Composite Bridge Constructability - Staged" design 

checks. When this occurred, no results were available. 

 72294 An incident was resolved for bridge superstructure design and rating where a design or rating 

request for a steel I-girder bridge would fail to run with an error message if the bridge section 

included a nonprismatic frame section that was defined to contain both a regular steel I-section and 

a hybrid I-section and if the location of the section transition between these two types of I-girders 

matched a bridge section cut location. When this occurred, results for the design or rating request 

were not available. Replacing the regular I-girder sections with equivalent hybrid I-girders in such a 

case enabled the request to run. 

 73244 An incident was resolved for bridge superstructure design and rating using the AASHTO LRFD 

2007 and 2012 design codes where the effective shear depth was not correctly calculated for shear-

type design and rating checks. In particular, the depth de (as defined in equation AASHTO LRFD 

5.8.2.9-2) was being calculated using fy = 0, where fy is the yield stress of the longitudinal rebar. 
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* Incident Description 

The affected design and rating types are the Multicell Concrete Box Shear and the Precast 

Composite Shear for concrete I- and U-girders. The computed shear depth was reported in the 

design tables. 

 73859 An incident was resolved for Bridge Design Optimization where an error message "Error in 

applying modified beam plate sizes to analysis model" could be generated when trying to perform 

the operation Save as a New Model after making changes to stiffeners and/or plate sizes and then 

recalculating the resistance. This only occurred for bridge sections defined using rolled steel I-

sections, rather than using hybrid steel I-sections. All Steel I Composite design and rating requests 

were affected for all codes. Results that were already calculated were correct and were not affected. 

 74007 An incident was resolved where the unbraced length, Lb, calculated for steel girder superstructures 

was incorrect where some span segments were defined with no supports (abutment or bent). The 

bridge design and rating requests assumed that the flange without composite slab was laterally 

braced at each end of every span segment. This resulted in evaluation of incorrect Lb values in 

situations where there were no supports at one or both ends of a span segment. This affected all 

design and rating requests for steel I-girder and steel U-girder bridge sections for all design codes. 

Most bridge models were not affected, only those using span segments to change bridge sections 

between supports. Models using nonprismatic frame sections to model varying steel girders were 

not affected. For models that were affected, it is necessary to update the linked bridge model in the 

new version to correct this problem. Models created in the new version will not be affected. 

 74884 An incident was resolved for bridge superstructure design and rating optimization of steel girder 

composite bridge sections where web panels with closely spaced diaphragms were being classified 

as unstiffened. This affected the Steel I-girder and U-girder Composite bridge sections, and affected 

the following design and rating requests for all codes: Steel I and U Comp Strength, Web Fatigue, 

and Constructability. When this occurred, the error was obvious from the reported classification. 

* 74888 An incident was resolved for the Bridge Rating of steel-I-girder bridge sections using the AASHTO 

codes where the user-specified system factor PhiS was being applied to both flexure and shear at the 

strength limit state, whereas per Section 6.A.4.2.4 of "The Manual for Bridge Evaluation" a constant 

value of PhiS = 1.0 is to be applied when checking for shear in this case. The affected rating request 

type was AASHTO (2007 and 2011) Steel I Comp Strength. In addition, the names of the rating 

parameters "Flexure PhiC" and "Flexure PhiS" in the Superstructure Rating Request Parameters 

forms for all AASHTO steel I-girder rating requests have been changed for clarity to "Condition 

Phi" and "System Phi", respectively. 

* 74531 

75250 

An incident was resolved for automated bridge seismic design under Seismic Design Category D 

(SDC = D) where the calculated concrete column hinge length was not correct in certain cases, 

depending upon the value of the relative height (RH) specified for the point of contraflexure. The 

hinge length is based primarily on the effective height (Heff) of the column, which is measured 

from the point of maximum moment to the point of contraflexure, but not exceeding the physical 

clear height (H) of the column. The point of contraflexure is specified by the user in the range -1 <= 

RH <= 2, where RH = 0 is the bottom of the column, and RH = 1 is the top of the physical column. 

Previously the effective height was being calculated as Heff = |RH| * H, subject to Heff <= H, and 

used for both the top and bottom hinges. This could lead to excessively small hinge lengths when 

RH was near zero, and invalid hinge lengths when RH = 0, such that the hinge would be omitted 

from the analysis model. In addition, the two hinge lengths should not necessarily be the same. This 

has been corrected as follows: For the bottom hinge, Heff = |RH| * H, subject to H/2 <= Heff <= H; 

for the top hinge, Heff = |RH - 1| * H, subject to H/2 <= Heff <= H. Models where the value of RH 

was specified to be -1, 1/2, or 2, or approximately so, were not affected by this error. All other 

models should be rechecked with the new version as the ductility capacity could have been over- or 

under-estimated. Note that the hinge length actually assumed was provided in the definition of the 

generated hinges. The effect of this error was moderated by the fact that the hinge length also 

depends upon rebar diameter, not only Heff. Designs for SDC = B and SDC = C were not affected. 

Steel columns were not affected. 

* 76762 An incident was resolved for the bridge design Steel Optimization procedure where the "As 

Designed Results" for a Design or Rating Request could be incorrect due to units conversion. This 

error only occurred when, prior to opening the Optimization form, the model units were set to be 
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* Incident Description 

different from the units that were in effect when the Design/Rating check was originally run. This 

caused an erroneous evaluation of steel material properties (fy and E) in inconsistent units for the 

"As Designed" resistance calculation. The original "As Analyzed" results were not affected and 

were correctly calculated. Re-running the Design/Rating Request with the changes made in the 

Optimization form generated the correct results. This error affected all Design/Rating check types 

all that are supported for Steel Optimization (commands Design/Rating > Superstructure Design > 

Optimize or Design/Rating > Load Rating > Optimize). 

 77394 An incident was resolved where the condition and system factors were not being correctly applied 

in certain circumstances when using the AASHTO MBE rating equation (MBE eq. 6A.4.2.1-1). In 

particular, the factors were incorrectly assumed as equal to one (1.0) for ultimate flexural rating in 

cases where the rating was controlled by positive flexural capacity. In cases where the rating was 

controlled by negative flexural capacity the correct values of the condition and system factors were 

being applied. This affected the AASHTO rating requests of types Precast Composite Flexure and 

Multicell Box Flexure. 

 77537 An incident was resolved where the automatic load combinations generated for bridge design per 

the AASHTO LRFD 2007, 2012 and Caltrans codes used a factor of 1.0 instead of 0.5 on 

temperature-gradient loads when live load was also included in the combination. When this error 

occurred the generated load combinations were readily visible and editable by the user, and results 

agreed with the load combinations as generated. Now temperature-gradient loads use a factor of 1.0 

when live-load is not included and 0.5 when live load is included, as specified by these codes. 

Frame Design 
Incidents Resolved 

* Incident Description 

 71163 An incident was resolved for frame design where attempting to right-click on a frame member while 

viewing design results saved from a previous CSiBridge session would cause an abnormal 

termination error. No results were affected or lost. Running the design, even for a single member, in 

the same session would prevent this problem. Only version 17.1.1 was affected. 

 73670 An incident has been resolved in the database tables for the steel frame design code AASHTO 2007 

in which the phi parameters in the tables did not reflect the actual phi factors used in the program 

and the phi factors input in the preferences form. Minor updates in the other database tables have 

also been made to reflect the variable names. These were reporting problems only. Actual 

calculations and results were correct. 

 75026 An incident has been resolved where the message for shear failure when using concrete frame 

design using the AASHTO 2007 code was not clear. This happened when flexural capacity could 

not be calculated for shear design purposes. The results were correct. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 71250 An incident was resolved where concrete frame design results were not fully available after 

reopening a model in a new CSiBridge session. Design results could be displayed graphically on the 

model window, but attempting to right-click on a member for detailed results would produce an 

abnormal termination error. Similarly, tabular results were not available in the situation. Running 

the design, even for a single member, after reopening the model would enable the display and 

output of the correct design results for all members. Result values were not affected by this error, 

which affected only version 17.0.0 to v17.1.1. 

 72007 An incident was resolved where the bridge seismic design report could not be generated in the case 

where the response-spectrum curve used for a bridge seismic design request was of type user-

defined. Results were not affected, and the results from the bridge seismic design could be viewed 

graphically and in tabular format. 

 73135 An incident was resolved in which discontinuities could occur in the girder response plots when the 
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section changed from variable depth to constant depth. 

 73378 An incident was resolved where the hinge status (LS, IO, CP) shown in the table “Frame Hinge 

States” could be incorrect for load combinations and for load cases when enveloping results were 

requested. This could also affect the plotted hinge status for enveloped results. The hinge status was 

correct for individual steps of a load case. The hinge state (A, B, C, D, E) was not affected. 

* 73600 An incident was resolved where the frame stress plots (command Display > Show 

Frame/Cable/Tendon Force Diagrams) could be incorrect when consecutive frame objects were 

assigned a nonprismatic frame section property with the advanced setting, i.e., the length of the 

frame object was less than the full length of the nonprismatic section variation. This could also 

affect the stresses reported in the table "Element Stresses - Frames". This did not affect frame 

objects that contained the entire length of the nonprismatic variation (the most common case), even 

though the object could be meshed into multiple frame elements for analysis. No other results were 

affected (such as frame forces and moments, displacements, and reactions). 

 76702 An incident was resolved affecting the bridge response display (command Home > Show Bridge 

Superstructure Forces/Stresses) for prestressed concrete U-girder sections where the longitudinal 

stress reported at the top left of the beams (U-girders) was actually the stress at a distance D5 below 

the top left corner of the beam for the case where the U-girder frame section was defined such that 

the exterior edge of the two webs were not smooth (i.e., D4, D5 and B6 were not zero). The stresses 

at all other locations were being reported correctly. This error could affect design results. The 

significance depended upon the size of the dimension D5. 

 77622 An incident was resolved where an Abnormal Termination error occurred when the influence line 

for a frame object was requested in tabular format in the Show Influence Line/Surface form. This 

error did not occur for other object types. No results were affected. 

 77736 An incident was resolved where correspondence results were not available for the tables "Bridge 

Object Forces" and "Bridge Object Girder Forces", even when the table "Output Options" for Multi-

Valued Response Combos was set to "Correspondence". Instead, the correct maximum and 

minimum values were presented with all corresponding values set to zero. This also affected the 

same results when obtained using the API (Application Programming Interface). This error was 

introduced in v17.0.0. 

Database Tables 
Incidents Resolved 

* Incident Description 

 70888 An incident was resolved for the Bridge Modeler where an error occurred when importing the 

database table "Bridge DesReqSuper 01 - General" or "Bridge RateReqSuper 01 - General" into an 

existing file. When this occurred, the software became unresponsive and results were not available. 

 74197 An incident was resolved where using the interactive database editor to modify the area object 

thickness overwrites for area objects with more than four points could cause an error. In some cases, 

the interactive database could become unresponsive when applying the changes to the model. In 

other cases the changes would be accepted but the analysis would not run, giving an error message 

instead. In both situations, results were not available. Exporting the table, modifying it, and re-

importing the table as an addition to the model did work correctly, as well as modifying the area 

thickness overwrites using the menu assignment command. 

 74474 An incident was resolved for the Frame Section Properties 01 - General database table in which the 

total mass and weight columns were not being populated for joist and nonprismatic sections. This 

was only an issue with the presentation of the data and did not affect results. 

* 74549 

76561 

An incident was resolved where the section cut forces reported in the database table "Section Cut 

Forces - Design" may have been reported incorrectly for some section cuts if the following two 

conditions occurred: (1) Results were displayed for more than one load case at the same time, and 

(2) The load cases requested contained response spectrum cases. If both of these conditions 

occurred the response spectrum case results could be from one of the other selected load cases. 

 76009 An incident was resolved in which the construction scheduler data could become corrupted after 

making changes using the interactive database. 
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 76147 An incident was resolved where exporting database files (Text, Excel, Access) was quite slow when 

an alternate language file, CSiLanguageResource.xml, was present in the installation folder. This 

also made saving the model file slow, since the *.$2k text file is written as a database file. No 

results were affected in any case. 

Data Files 
Incidents Resolved 

* Incident Description 

 74394 An incident was resolved in which the table "Tendon Section Definitions" would not be exported 

completely for a model where the number of the tendon section properties was greater than the 

number of the frame section properties. This affected the export to text, Excel, and Access files, 

including the .$2k text file. Without the complete tendon section data, the model could not be 

imported correctly, resulting in error messages during import. Results for the exported model were 

unaffected. Results for the imported model were consistent with the model as imported. 

 76061 An incident was resolved where importing a database file using the add to existing model option 

could cause existing bridge layout lines to be reset to default values. 

 77422 An incident was resolved where an error message was generated when importing an exported 

CSiBridge database table file (.b2k or .$br text, Excel, or Access) that contained more than 20 

bridge design requests, whether of types superstructure design, rating, and/or seismic design. When 

this occurred, the model could not be imported. Deleting some of the design requests from the 

database table file enabled it to be imported. 

Documentation 
Incidents Resolved 

* Incident Description 

 72257 An incident was resolved in the context sensitive help (F1) for the topic 'Vehicle Data Form', in 

which a typo existed for specifying the scale factor units for HA and HB vehicles. This was a 

documentation error only. 

 73357 An incident was resolved in the context sensitive help topic 'Bridge Rating Request Superstructure 

Form' in which the Rating Type bullet point mentioned stress checks which currently are not 

available for rating. 

 76409 The documentation for creating plugins was clarified to reflect updates to the CSiBridge API. The 

cSapPlugin interface has been replaced with cPluginCallback. 

 76415 An incident was resolved to correct the Analysis Reference Manual, Figure 18 equation for the 

calculation of the shear area of thin walled circular tube sections. The previously documented 

equation was not what the software was using. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 73602 An incident was resolved where the API command SapModel.File.OpenFile could not open *.$br 

files. 

 


